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Visual 1: Unit 1 - Basic Concepts in Benefit-Cost Analysis (BCA) 
 

 

Welcome to Unit 1 of the Introduction to Benefit-Cost Analysis (BCA) course. This unit focuses on 

basic concepts in BCA. 

 

The Student Manual is needed for this unit.
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Visual 2: Unit 1 Overview 
 

 

Unit 1 will cover several topics: 

• Introduce students to the basic concepts behind Benefit-Cost Analysis (BCA). 

• Introduce students to the role of the BCA in Hazard Mitigation Assistance (HMA) grants. 

• Introduce students to the basic terms used when discussing BCA.
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Visual 3: Unit 1 Objectives 
 

 

The purpose of this unit is for students to become familiar with the basic concepts behind Benefit-Cost 

Analysis (BCA). Once the unit is complete, students should be able to: 

• Describe the basic terms used in Benefit-Cost Analysis (BCA). 

• Explain how to determine when to do a BCA and when it will be cost effective. 
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Visual 4: What is Benefit-Cost Analysis (BCA)? 
 

 

Benefit-Cost Analysis (BCA) is the process of comparing the advantages of an action to its costs. 

 

We’ll discuss BCA in relation to hazard mitigation projects more in Unit 3. For now, let’s focus 

on learning the basic concepts behind BCA. 
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Visual 5: What is Benefit-Cost Analysis (BCA)? 
 

Although BCA may seem like a difficult concept, you probably already practice it in your everyday 

life. For example, have you ever considered questions like the following? 

• Is a warehouse club membership worth it? 

• Should I fix that leaky toilet in my house? 

• Should I buy or rent a house? 

 

Can you think of other examples where you practice BCA in your life? 
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Visual 6: Benefits and costs 
 

 

We will discuss benefits and costs specific to hazard mitigation projects more in Unit 3. For now, 

let’s consider the example of the leaky toilet. 

 

What are some benefits of replacing it? Are these benefits quantifiable (that is, able to be put into 

dollar terms)? 

 

 

 

 

 

What are the costs of replacing it? 
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Visual 7: Benefits and costs 
 

 

Some benefits of replacing the toilet may include: 

• Lower water bills 

• Reduced damage to floor 

• Less worry about damage? 

• Reduced time spent fixing leak or cleaning up mess? 

 

Can we quantify all these benefits? If not, should we include them in our BCA? 

 

 

Some costs of replacing the toilet may include: 

• The cost of the new toilet plus any materials 

• The cost to pay someone to install the toilet 

• Time taken away from other activities to do it yourself 

• Potential maintenance costs with new toilet 
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Visual 8: Cost-effectiveness 
 

 

If an action’s benefits are greater than its costs, then it is considered to be cost-effective. 

 

Once we add up the benefits of an action, we divide that value by the costs. This gives us the 

Benefit- Cost Ratio (BCR). 
 

𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 
 

 

𝐶𝐶𝐶𝐶𝐵𝐵𝐵𝐵𝐵𝐵 

 

= 𝐵𝐵𝐶𝐶𝐵𝐵 

 
 

If the BCR is greater than 1.0, then the action is considered cost-effective. 
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Visual 9: Cost-effectiveness exercise 
 

 

Do you think it is worth $1 million to protect these structures from flooding? Why or why not? Fill 

out the table below. 

 
 Probably Probably Not 

1. Protect one vacation home? 
  

2. Protect one government building that floods 
infrequently? 

  

3. Protect a flood-prone hospital or wastewater 
treatment plant? 

  

4. Protect 150 flood-prone 
houses? 
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Visual 10: Results of Cost-effectiveness exercise 
 

 

Intuitively, we know that a million-dollar mitigation project to protect one vacation home or a 

building that doesn’t flood frequently is probably not a good investment. 

 

On the other hand, a million-dollar mitigation project to protect a large number of flood-prone 

houses or important buildings is probably a worthwhile investment. 

• Cost is always a key determinant of cost-effectiveness. Protecting a hospital may be 

cost- effective at $500,000 but not if the mitigation project costs $5,000,000. 

 

Why are the last two projects worth doing, while the first two are not? 
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Visual 11: Applications of BCA 
 

 

BCA can be used multiple ways. For one, it can be used to determine if a single action is cost-

effective in comparison to the status quo: 

• For example: Should I replace that leaky toilet, or leave it as-is? 

 

Or, it can be used to determine the most cost-effective option out of several. 

• For example: Should I (1) replace the leaky toilet, (2) try to repair it, or (3) remodel my 

entire bathroom? 

• It is important to note that the last option, remodeling the bathroom, could very well 

be cost-effective when compared to the status quo. But it is unlikely to be the most 

cost- effective option. 

 

For hazard mitigation projects, we are usually doing the first way, since we do not require 

applicants to show that they are choosing the most cost-effective option. 

 

Remember that the BCA is only one component subapplicants must consider when determining 

which project is their preferred option. The other components are discussed briefly in Unit 3 and in 

more detail in E0212. 
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Visual 12: Why should I do a BCA? 
 

 

There are several reasons you should do a BCA. They include: 

• A BCA is a required component of most HMA project applications 

• A BCA is required for some 406 (Public Assistance) mitigation projects 

• BCAs help communities and sub applicants make informed decisions about their risks and 

money and prioritize projects 

 

We’ll discuss the statutory and regulatory requirement for BCA in the next unit. 

 

For those of you who’ve taken the 212 courses, HMA: Developing Quality Application Elements, 

you should know why you need to conduct a Benefit-Cost Analysis. For those who haven’t taken 

the 212 course, it’s important to know that a Benefit-Cost Analysis is a required component of a 

complete Hazard Mitigation Assistance project sub application. 
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Visual 13: Other Common BCA terms 
 

 

Now let’s discuss a couple of other terms commonly used in BCA: 

• Discount rate 

• Net present value
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Visual 14: Discount rate 
 

If I offered you $100 today, or $100 one year from now, which would you choose? 

Why? You’d probably choose to have $100 today because: 

• $100 invested today might result in $106 one year from now. 

• $100 one year from now might only buy $97 worth of goods. 

 

Because benefits are worth more if they are experienced sooner, future benefits must be 

discounted. The rate at which benefits decline in value each year is the discount rate. 

 

Federally-funded mitigation projects must use a discount rate of 7%, which is set by the U.S. 

Office of Management and Budget (OMB). We’ll discuss this more in Unit 3. 

 

How do you think using a higher or lower discount rate for a mitigation project would affect the BCR? 
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Visual 15: Discount rate example 
 

 

Let’s say I have a mitigation project with $100 in benefits in Year 1. With a discount rate of 

7%, my annual benefits would be as follows: 

 
 

Annual benefits 

Year 1 $100 

Year 2 $93 
Year 3 $86 

Year 4 $80 
Year 5 $75 

 

As you can see, the benefits are reduced by 7% each year. 
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Visual 16: Net Present Value 
 

 

Net present value (NPV) is the value today of benefits that you will receive in the future, minus the 

value today of costs that you will incur in the future. 

 

 

𝐹𝐹𝐹𝐹𝐵𝐵𝐹𝐹𝐹𝐹𝐵𝐵 𝑏𝑏𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 (𝐵𝐵𝐵𝐵 𝐵𝐵𝐶𝐶𝑡𝑡𝑡𝑡𝑦𝑦′𝐵𝐵 𝑡𝑡𝐶𝐶𝑑𝑑𝑑𝑑𝑡𝑡𝐹𝐹𝐵𝐵) − 𝐶𝐶𝐶𝐶𝐵𝐵𝐵𝐵𝐵𝐵 (𝐵𝐵𝐵𝐵 𝐵𝐵𝐶𝐶𝑡𝑡𝑡𝑡𝑦𝑦′𝐵𝐵 𝑡𝑡𝐶𝐶𝑑𝑑𝑑𝑑𝑡𝑡𝐹𝐹𝐵𝐵) = 𝑁𝑁𝐵𝐵𝐵𝐵 𝑃𝑃𝐹𝐹𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 𝑉𝑉𝑡𝑡𝑑𝑑𝐹𝐹𝐵𝐵 (𝑁𝑁𝑃𝑃𝑉𝑉) 

 

A positive NPV indicates that something is a good investment. 
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Visual 17: Net Present Value example 
 

 

Example: Let’s say I would like to rent out my basement. In order to make the space rentable, I will 

have to spend $25,000 to renovate it and get a certificate of occupancy. The basement will rent for 

$1,000 per month, and I plan to rent it out over a period of 3 years. 

 

Is this a good investment? How can I figure this out? 

 

Note: This is a very simplified example and does not take inflation, rent increases, etc. into account. 
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Visual 18: Net Present Value example 
 

 

First, let’s figure out the first part of our equation: future benefits in today’s 

dollars. We calculate this by using the discount rate. 

• In Year 1, my benefits from owning the rental property are $1,000 x 12 = $12,000. 

• What are my benefits in Year 2? (Hint: It’s not $12,000.) 
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Visual 19: Net Present Value example 
 

 

Recall we have a discount rate of 7%. 

 

Since my benefits are reduced by 7% each year, my total benefits over the 10-year period are: 

 
 

Annual benefits 

Year 1 $12,000 
Year 2 $11,520 

Year 3 $11,059 

Sum: $33,539 
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Visual 20: Net Present Value example 
 

 

Now that we have calculated the value of our future benefits in today’s dollars ($33,539), 

let’s determine the costs. 

 

In this very simplified example, the costs are my original investment of $25,000. 



Introduction to Benefit-Cost Analysis Unit 1 Basic Concepts in Benefit-Cost Analysis 

June 2019, Version 2.0 Student Manual Page 1-23 

 

 

 

 

 

 

Visual 21: Net Present Value example 
 

 

My Net Present Value (NPV) is $8,539, which is a positive number. 

 

$33,539 − $25,000 = $8,539 
 

 
Answer: Yes, I have a positive NPV, so I made a good investment. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

FEMA BCA Toolkit 6.0 Installation 

Instructions  
 

This page features installation and launch instructions for FEMA’s Benefit-Cost Analysis 

(BCA) Toolkit Version 6.0. You can use BCA Toolkit 6.0 in Excel Desktop or in Excel 

Online. 

Excel Desktop 
 

The following directions are for using BCA Toolkit 6.0 in the desktop version of Excel. 

(Excel 2013 or newer is required.) 

1. Click the “Download the BCA Toolkit Version 6.0” button on the Benefit-Cost 

Analysis page and open the Excel file. 

2. (FEMA computers should skip this step) In the Insert tab, in the Add-ins section, 

click on My Add-ins. Select the Store option and search for FEMA Benefit-Cost 

Analysis Calculator. Click Add. 

3. On the Home tab, you should now see the FEMA BCA V6.0 icon in the upper 

righthand ribbon. 

4. Click on the FEMA BCA V6.0 icon. A sidebar will open. 

5. Click Open Calculator to begin your BCA. 

6. The add-in window will open and take you to the home screen. From here you can 

start a new project by clicking Add Project. 

7. To save your work, click "Finish" on the second screen, close the add-in window, 

and save the Excel file, renaming it as desired. 

Excel Online 
 

The following directions are for using BCA Toolkit 6.0 in Excel Online. Excel Online 

works best in Firefox and Chrome browsers. 

1. Click the “Download the BCA Toolkit Version 6.0” button on the Benefit-Cost 

Analysis page and save the Excel file to your machine or OneDrive. 

2. If you do not already have one, create a free Office 365 account. 

3. Once logged in, open Excel Online by clicking on the Excel icon under Apps. 

4. Open the file BCA Toolkit 6 xlsx in Excel Online by clicking Upload a Workbook 

In the Insert tab, click Office Add-ins. Select the Store option and search for FEMA 

Benefit-Cost Analysis Calculator. Click Add. (If you get a message saying Microsoft 

365 has been configured to prevent individual acquisition of Office Add-ins, you can 

https://www.fema.gov/fact-sheet/fema-bca-toolkit-60-installation-instructions
https://www.fema.gov/fact-sheet/fema-bca-toolkit-60-installation-instructions
https://www.fema.gov/grants/guidance-tools/benefit-cost-analysis
https://www.fema.gov/grants/guidance-tools/benefit-cost-analysis
https://www.fema.gov/grants/guidance-tools/benefit-cost-analysis
https://www.fema.gov/grants/guidance-tools/benefit-cost-analysis
https://www.office.com/


 

 

sign out and sign in using a personal account.) 

In the Insert tab, click Office Add-ins. Select the Store option and search for FEMA Benefit-

Cost Analysis Calculator. Click Add. (If you get a message saying Microsoft 365 has been 

configured to prevent individual acquisition of Office Add-ins, you can sign out and sign in 

using a personal account.) 

1. You should now see the FEMA BCA button in the top righthand side in the Home 

tab. 

2. To launch the Toolkit, click on the FEMA BCA button. A sidebar will open. 

3. Click Open Calculator. You may be asked if you want to allow your browser to 

open another window. Click Allow. 

4. The add-in window will open and take you to the Home screen. From here you can 

start a new project by clicking Add Project. 

5. To save your work, click “Finish” on the second screen and close the add-in 

window. IMPORTANT: You must make sure to save a copy of the file to your local 

machine by clicking File, Save As, Download a Copy, and choosing the “Open with 

Microsoft Excel” option. Once the file opens, click File, Save As, and save a copy 

to your local machine. To reopen the file in Excel Online, click Upload a Workbook 

and navigate to the file on your local machine. 

Technical Assistance 
 

FEMA’s BCA Helpline is available to provide assistance using the BCA Toolkit, including 

with troubleshooting technical issues. The BCA Helpline cannot review or perform 

benefit-cost analysis. For help reviewing or performing BCA, or to ask eligibility or policy 

questions, please contact your local state hazard mitigation officer. 

The BCA Helpline’s hours are 9 a.m. – 5 p.m. (EST), Monday through Friday. Email 

questions to bchelpline@fema.dhs.gov or call toll free at 1-855-540-6744. 

mailto:bchelpline@fema.dhs.gov
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